Flame Painter Manual

v.3.2 Personal | Profesional

Introduccion

iBienvenidos a Flame Painter!

Flame Painter es una aplicacion de pintura Unica que le permite crear facilmente obras de arte
originales, efectos de luz, disefios poco convencionales o fantasticos fondos con pincel de
llama.

Fue creado como un proyecto experimental en mi serie ‘Yo soy un artista’. La vision inicial era
crear una aplicacién en la que cualquier persona podria crear algo hermoso. Fue hecho tanto
como una herramienta para los artistas, asi como para las personas sin habilidades artisticas
que quieren crear algo Unico.

La falta de inspiracién y motivacion a menudo son las razones por las que las personas no son
creativas, sin embargo, las herramientas que utilizamos pueden llegar a ser la inspiracion para
la creatividad. Creo que con las herramientas que te inspiran, todo el mundo puede ser artista.
Por eso nacié Flame Painter.

Esta es la tercera versiéon de Flame Painter. Hay muchas nuevas caracteristicas incluidas —
“Flame Painter Connect” - un plug-in de Photoshop que funciona como un conexidn directa
entre Flame Painter y Photoshop, con la capacidad de utilizar |apiz sensible a la presidon de
Wacom tableta y la cdmara delLeap Motion, una importacidn y exportacién fluida de PSD con
capasy SVG archivos vectoriales. EIl motor de multi-core, nuevo renderer para alta resolucion y
los modos de fusidn de Photoshop que han hecho de este software una herramienta poderosa
para crear obras de arte profesionales.

Este manual describe las caracteristicas de la aplicacién y le dice lo que necesitas saber para
obtener la pintura. Hay una serie de pardmetrosdisponibles de pincel de Ilama, sdlo
experimente con diferentes ajustes de pincel y tal vez encontrard una manera creativa
completamente nueva de la auto-expresion.

iGracias por comprar Flame Painter! Espero que pase gran tiempo con la pintura!

Peter Blaskovic
creadorde Flame Painter



Ventana de Interfaz de Usuario
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Brush / Pincel - Elige la herramienta Pincel
Pen / Pluma — Elige la herramienta Pluma

Eraser / Borrador - Elige la herramienta
Borrador
Fill / Relleno - Elige la herramienta Relleno

Transform / Transformar - Mueva y cambie el
tamanio de la capa seleccionada

Edit Vector Layer / Editar Capa Vectorial — Edite
el modo de la capa vectorial seleccionada

Zoom Out / Alejar - Aleja la pintura (a un
tamafio minimo del 5%).

Zoom In / Acercar- Acerca la pintura (a un
tamafio maximo de 800%).

T Reset Zoom / Restablecer Zoom -

Q

Compruebe el valor de zoom aqui. Pulse el
botdn para restablecer el zoom al 100%.
Undo / Deshacer - Deshace la tltima operacion

de pintura que ha realizado.
Redo / Rehacer - Rehace la Ultima operacion de
deshacer.



Brush / Pincel

Hay tres modos de pintura diferentes:

Flame / Llama - El modo de pintura de llama clasico.

@ ZNIE Follow / Siga - La pincelada seguira el ratén con mayor precision, unpincel a base

de linea.
|- Ribbon EEELEL / Cinta - El modo de pintura cinta, la pincelada se extiende un poco mas
amplio.

Blending / Fusidn - El modo de fusion de color. Hay tres modos de fusién

- Normal para la pintura ordinaria,

- Lighten / Modo claro (modo aditivo) es por lo general para los efectos de luz y fondos
oscuros 'y

- Darken / Modo oscuro (modo sustractivo) de fondo mas claro.

Opacity / Opacidad - Opacidad del pincel (0 - 100)

Flame / Llama, Follow / Siga y Ribbon / Cinta parametros del pincel
Estos son los parametros de la Herramienta de Pincel para experimentar:

Size / Tamaiio - Tamario delPincel—-el nimero de puntos del pincel (1-300)

Span / Ancho - Ancho del Pincel (0 - 10)

Dist - Distancia entre lospuntos del pincel (1 - 20) - esta opcidn se puede establecer si las
"Lines" estan "On"

Soft / Suave — Suavidad del Pincel (1 - 100) - efecto del pincel mas global

Speed / Velocidad - Velocidad del Pincel (1 - 100) - el tiempo de la reaccion del pincel; cuanta
mas alta la velocidad, mas preciso el pincel.

Center / Centro - Fuerzas Globales (0 - 100)

Focus / Foco - Fuerzas Locales (0 - 100)

Chaos / Caos - El Pardmetro Muy Cadtico (0 - 100) - cdmo cadticamente puntos del pincel
oscilan alrededor del pincel

Noise / Ruido - El Parametro de Ruido Loco (0 - 100) - cuanto mas alto el nimero, mas ruidoso
el pincel

Todos parametros estan en la correlacion mutual. Cada ajuste influye la forma del pincel
definitivo.

Fade / Fundido - Pincel de Fundido: Fade In/Out (0 - 10). Ajuste el tiempo de Fundido / Fade
In/Out.

:E Fill / Relleno| Lines / Lineas - Cambiar entre "Fill / Relleno" y el modo de "Lines /
Lineas".

Detail / Detalle - Pincel de Detalle (1 - 4). Ajuste la calidad del detalle de la pincelada. Utilicelo
si quiere unapincelada detallada y suave, o si usted ha configurado un tamafio del lienzo mas



grande.

Nota: Al establecer el pardmetro mds alto, la pintura puede reducir la velocidad por su

intensivocalculo.

. B| Antialiasing (AA) - Cambie entre "Antialiasing Normal" y "SuperSmooth Antialiasing"
Nota: Al establecer el pardmetro en "SuperSmooth Antialiasing”, la aplicacion puede
reducir la velocidad, porque es mds intensivo de calcularque "Antialiasing Normal".
Esta caracteristica estd disponible en la edicion PRO.
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Pen / Pluma
Ajuste los parametros de la herramienta Pluma:

Blending / Fusion - El modo de fusidon de color. Hay
tres modos de fusién

- Normal para la pintura ordinaria,

- Lighten / Modo claro (modo aditivo) es por lo general
para los efectos de luz y fondos oscuros y

- Darken / Modo oscuro (modo sustractivo) de fondo
mas claro.

Size / Tamaiio - Tamafio de la herramienta Pluma (1-
200)

Hardness / Dureza - Dureza de la herramienta Pluma
(0-100)

Step / Paso - Paso de la herramienta Pluma (0-100)
Opacity / Opacidad - Opacidad de la herramienta
Pluma (0-100)

Use sélo con Color. Transiciones del gradiente no estan disponibles en la herramienta Pluma.

Hardness

Step

Opacity

Eraser / Borrador
Ajuste los pardmetros de la herramienta Borrador:

Size / Tamaiio - Tamafio de la herramienta Borrador (1
- 200)

Hardness / Dureza - Dureza de la herramienta
Borrador (0 - 100)

Step / Paso - Paso de la herramienta Borrador (0 - 100)
Opacity / Opacidad - Opacidad de la herramienta
Borrador (0-100)



Fill / Relleno

La capa se puede llenar con la paletade "Color" o de
"Gradiente". Si se elige el Gradiente, la capa se puede
llenar verticalmenteo horizontalmente.

Verticalmente | Horizontalmente - Cambie entre
Relleno "Vertical" y "Horizontal".

Transform Layer / Transformar Capa

Mueva y escala la capa seleccionada. Haga clic en “OK”
para acceptar los cambios o Cancelar sidecide no
hacerlo.

Si desea transformer y editar la Capa Vectorial
(disponible en la edicion Pro), presione el boton “Edit
Vector Layers” / “Editar Capas Vectoriales”.

Editar Capas Vectoriales - Pro edicion

Paint Tool / Herramienta de Pintura - Pintar
una nueva pincelada. Puede pintar una
pincelada en una capa vectorial.

Edit Tool / Herramienta de Editar - Editar
vértices claves (puntos amarillos) y modificar el
vector creado. Haga clic en vértices (gris) para
cambiar a vértices claves (amarillos).

Group Edit Tool / Herramienta de Grupo Editar
- Editar grupo de vértices claves
(puntos amarillos).

Add & Remove Tool / Herramientas de Agregar y Quitar - Retire vértices editables
desde la linea de llama (atajo: Ctrl en Windows/Cmd en Mac OS).

m Curve Transform / Curva de Transformacidn - Cambiar el tamafio, rotar y escalar una
pincelada.

Init Curve Transform / Curva Init de Transformacion - Cambiar el tamanio, rotar y
reescalar una curva inicial de pincelada.

Capas vectoriales tienen una gran ventaja de edicién adicional de las pinceladas pintadas. En la
capa vectorial se puede pintar una pincelada que se puede, ademas, transformar y editar.
Después de pintar una pincelada, se puede cambiar cualquier pardmetro de pincel, modo de
fusidn, la opacidad, paletas del color y del gradiente o cambiar todo el pincel preestablecido
para otro. Es el modo de edicién muy flexible que si usted desea, ademads, puede equilibrar los
parametros para establecer la forma del major pincel.

Nota: Por favor tenga en cuenta que después de crear una nueva pincelada en una capa
vectorial, la anterior se borra. La creacion de una nueva capa vectorial para cada pincelada
editable se recomienda.



Palette Panel / Panel de la Paleta

Color / Color | Gradient / Gradiente - Seleccione si desea pintar o llenar la capa con un color o
con la transicion del gradiente.

Color
Il Gradient

Elija su color del pincel aqui.

H (Hue) - Matizdel Pincel (0 - 359)
S (Saturation) - Saturacién del Pincel (0 - 255)
L (Luminance) - Luminancia del Pincel (0 - 255)

Palette / Paleta - Seleccione el color del pincel
(+) () - ARadir y eliminar colores de colores
personalizados.

Un solo click en la caja de color abre un selector de
paleta. El color que se utiliza para pintar en el Lighten
Mode / Modo claro o Darken Mode / Modo
oscuropuede que no aparezca exactamente lo mismo
que se ve en el "Color Brush / Color de Pincel".Esto es
tipico de la aplicacion y el Modo claro / oscuro. Si usted
desea tener el color exacto, elija el Modo Normal.

Gradient / Gradiente

Bl Color Il Gradient

Elija y configure su transicion del gradiente.

Haga click en el botdn del color que desea cambiar y
seleccione el color de la paleta. Se puede activar /
desactivar el color que desea utilizar en el gradiente.

L e e e Rotate / Girar - Gire la transicion del gradiente.

B Length Flip / Voltear - Voltee latransicién del gradiente.
H | S| L- Cambie elmatiz, la saturaciény la
luminosidad de todos los colores en gradiente.

Set Gradient Length / Establecer Longitud de
Gradiente - Seleccione si desea utilizar gradiente para
un ancho o una longitud del pincel y ajuste la longitud
del gradient (1 - 10). Cuanto mads alto el nUmero, mas
frecuentemente se cambian los colores del degradado.

(+) (-) - ARadir y eliminar colores y gradientes a partir de las listas.



Brushes Panel / Panel de Pincel

Ventana de los pinceles preestablecidos, se puede abrir o guardar los ajustes del pincel aqui.

Use Palette / Utilice la Paleta - Utilice la paleta
guardada en elpincel

Utilice el Modo de Fusidn - Utilice el modo de fusién
7 ) (normal, claro o oscuro), que estd guardado en el

Combjelly F pincel.

£/ Share Brush / Compartir Pincel - Cargue su pincel a la
\6 -~ Galeria de Pinceles online. Haga clic en “Yes” para
£~ confirmar.
Flame Flamellnes Follow
Rainbow

(+) (-) - ARadir y eliminar pinceles preestablecidos de la
lista.

-

Para afadir un nuevo pincel preestablecido, haga clic

— en "Add Brush/Afadir pincel" (+), pinte en el icono del

‘\* @ Q \ 8) ‘ pincel, escriba el nombre del pincel y haga clic en Save
A M \ | / Guardar.

M Use Pa'-ettf‘ GC® 06 Un pincel nuevo aparecera en el menu Brushes /

B L Pinceles inmediatamente.

Huge Blue Nolse Rainbow

Nota: Al guardar el pincel en el Modo "Oscuro"”, sélo el fondo blanco estd disponible. Al guardar
el pincel en el Modo "Claro", sélo el fondo negro estd disponible.

Se puede Drag&Drop / Arrastrar y soltar los nuevos pincelesde la pagina web directamente en
la aplicacidn. Enlace a los pinceles gratis:
http://www.escapemotions.com/products/flamepainter/brushes/index.php

Nota: Algunos navegadores no pueden transferir los metadatos del pincel. Si arrastrar y soltar
(Drag&Drop) desde el navegador no funciona, use otro navegador para la funcion de arrastrar y
soltar. O se puede descargar el pincel desde el enlace arriba a la carpeta, que se puede
encontrar en el menu de Flame Painter: "Help" -> "Show Brushes Folder"-> "Brushes". Todos los
pinceles, que estdn en esta carpeta, aparecerdn en el Panel de los Pinceles.

Manual de como arrastrar y soltar y de como descargar los pinceles se puede encontrar en la
seccion de preguntas frecuentes (FAQs) en nuestro sitio web:
https://www.escapemotions.com/products/flamepainter/support.php




Layers Panel / Panel de Capas

Utilice la ventana del Panel de Capas para editar y manipular con capas.

Blending / Fusion - 22 modos de fusion de Photoshop:
Normal, Darken, Multiply, Color Burn, Linear Burn,
Lighten, Screen, Color Dodge, Linear Dodge, Overlay,
Opacity Soft Light, Hard Light, Vivid Light, Linear Light, Pin Light,
Hard Mix, Difference, Exclusion, Hue, Saturation, Color,
Luminosity y Subtract mode.

@® ™ Layer2 ¢ Opacity / Opacidad - Ajuste la opacidad de la capa. (0-

® Layer 1 100)

Blending Overlay

® My renamed layer 85

E Eye / Ojo - Muestre u oculte la capa activa (al
lado del icono de la capa).

@ Clean Layer / Limpiar Capa - Limpie el contenido
de la capa

+=)l Export to PS / Exportar a PS - Exporte la capa
seleccionada a Photoshop. Puede obtener mas
informaciénes sobre Flame Painter Connect - el
plug-in del Photoshop mads adelante en este
manual. Esta caracteristica estd disponible en la
edicion PRO.

HE BEDO

New Layer / Nueva Capa - Afiadir una nueva capa.

New Vector Layer / Nueva Capa Vectorial - Afiadauna nueva capa vectorial editable.
Esta caracteristica estd disponible en la edicion PRO.

Duplicate Layer / Duplicar Capa - Duplique capa o capas activas.

Merge Layers / Fusionar Capas - Fusione mas capas enuna capa.

Remove Layer / EliminarCapa - Elimine la capa o mas capas activas.

[m] OO &

Se puede cambiar el nombre de una capa activa con un doble clic sobre ella en una Lista de
Capas.
La capa vectorial se puede convertir a Mapa de bits en el mend.

Paneles de Paleta, de Pinceles y Capas son acoplables - es posible modificar, cambiar de
posicidn y ajustar del ancho de los paneles.



The Menu Bar / Barra de Menu

File / Archivo - Contiene acciones relacionadas con cargar, guardar, exportar y publicar sus
pinturas.

Edit / Editar - Contiene articulos relacionados con la edicién del proceso de pintura y el lienzo.
Layers / Capas - Contiene acciones relacionadas con las capas.

Filter / Filtro - Contiene acciones relacionadas con los filtros de imagenes y effectos.

View / Vista - Contiene acciones relacionadas con el viewport y la interfaz de usuario.
Window / Ventana - Contiene acciones relacionadas con la interfaz de usuario.

Help / Ayuda - Contiene acciones que permiten obtener ayuda de la aplicacién, o buscar
actualizaciones en la pagina web.

File Menu / Menu de Archivo

El Menu de Archivo contiene acciones relacionadas con su pintura de la siguiente manera:

New... / Nueva... - Abreel cuadro de didlogo que le permite crear una nueva pintura con los
nuevos ajustes.

Open... / Abrir... - Abreelcuadro de didlogo que le permite cargar una imagen desde disco.

Save / Guardar... - Guarde su pintura. Si no ha guardado anteriormente, se le pedird que
introduzca el nombre.

Save As / Guardar como... - Guarde una copia de su pintura actual como una nueva.

Import / Importar... - Abre una imagen a la nueva capa. La imagen se redimensionada
automadticamente al tamaio real del lienzo, pero se puede mover y cambiar a cualquier
tamaiio.

Export layer to SVG... / Exportar la capa a SVG... — Exporte la capa vectorial activa como
poligonos a formato grafico vectorial redimensionable (del inglés Scalable Vector Graphics).
Establece el nimero de poligonos con deslizador Detalle de 1- 4.

Esta caracteristica estd disponible en la edicion PRO.

Ejemplo: Si la capa vectorial se compone de 100 000 poligonos y Detalle se ajuste en 1, se
rendera y guarda 100 000 poligonos. Si se ajuste en 2, se cuadruplica el numero de poligonos,
por lo que el numero de poligonos serd de 400 000. Si se ajuste en 3, el niumero serd del 600
000.Si se ajsute en 4, el niumero de poligonos serd de 6 400 000.

Publish... / Publicar... - Publique su pintura en la Galeria de Flame Painter. Introduzca el
nombre de la pintura, opcionalmente escriba una descripcidén y etiquetas.

Publish preferences... / Preferencias de publicar... - Un sub-menu contiene preferencias de la
Galeria.



Preferences / Preferencias... - Ajuste preferencias de Safe Boundary, Wacom Tablet y Leap
Motion

- Safe Boundary - Se puede establecer el lienzo extendido con mas espacio visible que el
tamano del lienzo. Active y desactive una visibilidad y establece unTamafio (Size) y la Opacidad
(Opacity) de “Safe Boundary”.

- Wacom Tablet - Ajustes para trabajar con tabletas que soportan sensibilidad a la presion del
lapiz. Puede ajustar la intensidad de los parametros que deben ser influenciadas por la presion
del lapiz.

- Leap Motion - Ajustes para el controlador deLeap Motion. Permite pintar con el control de
movimiento de una mano. Seleccione tecla Shift para pintar con un dedo y utilice tecla "Shift"
como un botén del ratdn, o seleccione Show Two Fingers / Mostrar Dos Dedos para pintar con
dos dedos.

Quit / Quitar - Cierra la aplicacion. (Sélo en Windows)

Para obtener mas informacidén sobre como crear, cargar y guardar sus pinturas, consulte la
"Creacidn, Carga y Guardar de Pinturas" seccién mas adelante en el manual.

Edit Menu / Menu de Editar

Undo / Deshacer - Deshace la ultima operacidn de pintura que ha realizado. NUmero de pasos
para deshacer depende de la memoria de su computadora. NUmero maximo de estos pasos es
de 100.

Redo / Rehacer - Rehace la Ultima operacion de deshacer.

Image Size... / Tamafo de Imagen... - Un sub-menu contiene Ancho, Alto de imagen
redimensionada en pixeles y Safe Boundary en porcentaje.

Ejemplo: si crea una imagen con tamafo 1200 x 1200 pixeles y Safe boundary se ajuste en 10%,
el tamaiio deSafe boundary es 120 pixeles.

Compruebe Keep Aspect Ratio / Mantener relacion de aspecto, si desea redimenzionar la
imagen con la misma relacion de aspecto que la imagen actual.

Ejemplo: Si el ancho actual de la imagen es de 1200 pixeles y elalto es de 800 pixeles y desea
redimenzionar del ancho de la imagen a 2400 pixeles con la misma relacion de aspecto,
activarKeep Aspect Ratio y la aplicacion calculard la dimension restante - 2400 x 1600 pixeles.

Nota: Por favor, asegurese de guardar su imagen antes de cambiar el tamafio de la imagen.
Undo / Deshacer después elcambiodel tamario no estd disponible.

Copy / Copiar - Copie la capa hacia o desde cualquier aplicacién de terceros que soporta la
imagen con canal alfa en el clipboard.
Paste / Pegar - Pegue la capa hacia o desde cualquier aplicacion de terceros que soporta la
imagen con canal alfa en el clipboard.



También puede arrastrar y soltar (Drag & Drop) imagenes desde cualquier aplicacion o
navegador de Internet directamente a Flame Painter 3 si la aplicacidn lo permite.

Herramientas siguientes trabajan solamente con las capas vectoriales, de lo contrario estas
opciones aparecen en gris.
Estas caracteristicas estdn disponibles en edicion Pro.

Paint Tool / Herramienta de Pintura - Pinte una nueva pincelada. Se puede pintar una
pincelada en una capa vectorial.

Edit Tool / Herramienta de Editar - Edite vértices claves (puntos amarillos) y modifique el
vector creado. Haga clic en vértices (grises) para cambiar a vértices clave (amarillos).

Group Edit Tool / Herramienta de Grupo Editar - Edite grupo de vértices claves (puntos
amarillos).

Add & Remove Tool / Herramientas de Agregar y Quitar - Retire vértices editables desde la
linea de llama (atajo: Ctrl en Windows/Cmd en Mac OS).

Curve Transform / Curva de Transformacion - Cambie el tamafio, rote y escale una pincelada.
Init Curve Transform / Curva Init de Transformacion - Cambie el tamafio, rote y reescale una
curva inicial de pincelada.

Layer Menu / Menu de Capa

New Layer / Nueva Capa - Afiada una nueva capa.

New Vector Layer / Nueva Capa Vectorial - Aflada una nueva capa vectorial (disponible en
edicion Pro).

Duplicate Layers / Duplicar Capa - Duplica capa o capas activas.

Merge Layers / Fusionar Capas - Fusione capas en una sola capa.

Delete Layers / Eliminar Capa - Elimine capa o capas activas.

Show Layer / Mostrar Capa- Muestre u oculte la capa activa.
Transform Layer / Transformar Capa - Mueve y escale la capa activa.
Clear Layer / Limpiar Capa - Limpia la capa.

Export to Photoshop / Exportar a Photoshop - Exporte la capa con ajustes de la capa, con el
fusion y la opacidad desde Flame Painter a Photoshop.

Se puede encontrar mas informacién sobre Flame Painter Connect - el Photoshop Plug-in mas
adelante en este manual.

Convert to Bitmap / Convertir a la Mapa de bits - Convertela capa vectorial a la capa de Mapa
de bits. Esta caracteristica estd disponible en edicion Pro.

HiRes render... - Ajuste el detalle de Renderer de la Alta Resolucion (High Resolution Renderer)
(1-5). HiRes Renderer es un renderer poligonal. Llena el espacio entre los puntos y hace la
imagen mas suave y sin la aparicion de artefactos de Moire. Puede ser utilizado solamente con
capas vectoriales.

Cuando HiRes renderer es finalizada, la imagen renderizada reemplazara la capa actual. "HQ"
aparece en el panel superior y significa “high quality” ("alta calidad"). Cuando se realizan



modificaciones adicionales a la capa vectorial renderizada, HQ desaparece y la capa vectorial
necesita ser renderizada de nuevo.

Pulse la tecla Esc para cancelar la renderizacion. Por favor, espere hasta que el proceso se
detiene.

Esta caracteristica estd disponible en edicion Pro.

Nota: HiRes renderer estd muy intensivo para cdlcular y puede renderizar una capa vectorial
incluso unas horas. El tiempo de renderizar depende de la longitud del pincel, asi como de los
ajustes del pardmetro de "Tamafo". Cuanto mayor es la pincelada y el tamafio, mds tiempo se
necesita para renderizar.

Ejemplo: Si la capa vectorial se compone de 100 000 poligonos y Detalle de HiRes Renderer se
ajuste en 1, se puede renderizar 1 minuto. Si se ajuste en 2, se cuadruplica el numero de
poligonos, por lo que el numero de poligonos serd de 400 000 y va a renderizar 4 minutos. Si se
ajuste en 3, el numero serd de 1 600 000 y el tiempo serd de 16 minutos. Si se ajuste en 4, el
numero serd de 6 400 000 y el tiempo serd 64 minutos. Si se ajuste a 5, el numero serd de 25
600 000 y el tiempo serd 256 minutos, circa 4 horas.

Filter Menu / Menu de Filtro

Blur / Desenfoque - Establecer radio de desenfoque de una ventana emergente.

- Vista Preliminar - Mostrar u ocultar el resultado en tiempo real.
Glow / Brillo - Establecer radio y fuerza de brillo de una ventana emergente.

- Vista Preliminar - Mostrar u ocultar el resultado en tiempo real.

Tile Layer / Capa de Azulejos - Crear una capa de azulejos horizontalmente y verticalmente.

View Menu / Menu de Vista

Zoom In / Acercar - Acerca la pintura (a tamafio maximo de 800%).

Zoom Out / Alejar - Alejala pintura (a un minimo del 5%).

Zoom 100% / Acercar 100% - Comprueba el valor de zoom. Pulse el botén para reiniciar el
zoom al 100%.

Show Cursor / Mostrar el Cursor - Muestre u oculteel cursor.
Show Brush Dots / Mostrar Puntos de Pincel - Muestre u oculte puntos del pincel.



Window Menu / Menu de Ventana

Tools / Herramientas - Muestre u oculte el Panel de Herramientas
Palette / Paleta - Muestre u oculte el Panel de Paleta

Brushes / Pinceles - Muestre u oculte el Panel de Pinceles

Layers / Capas - Muestre u oculte el Panel de Capas

Stay on Top / Permanecer arriba - Aplicacion permanecerd siempre en la parte superior de
otras aplicaciones.

Fullscreen / Pantalla Completa - Cambie la ventana de la aplicacién en modo de pantalla
completa. (Presione Esc para salir).

Show Main Menu / Mostrar Menu Principal - Muestre u oculte el Menu Principal (Presione
Esc para salir). (Sélo en Windows, Menu Principal oculte automdticamente en Mac OS).

Help Menu / Menu de Ayuda

Help / Ayuda - Abrir este documento.

Send Feedback / Enviar Comentarios... - Envienos sus comentarios si usted tiene cualquier
problema, una idea o simplemente le gusta el programa. Introduzca su correo electrénico y
mensaje.

Flame Painter Website / Pagina web de Flame Painter - Enlace a la pagina web:
flame.escapemotions.com

About Flame Painter / Sobre Flame Painter - Obtener un poco de informacion bésica sobre
Flame Painter, copyright y créditos.

Show Brushes Folder / Mostrar la Carpeta dePinceles ... - Mostrar carpeta donde se guardan
los pinceles.

Online Brush Library / Biblioteca online de Pinceles ... - Mostrar biblioteca con pinceles
descargables.

Check for updates... / Buscar actualizaciones... - Este botén es visible cuando hay nuevas
actualizaciones disponibles.

Upgrade to Pro edition / Upgrade a la edicion Pro - Haga clic si desea actualizar de Personal a
la edicién Professional. Disponible en la edicidn Personal.



Flame Painter Connect

Flame Painter Connect es plug-in para Photoshop CS5, CS5.5, CS6 y Photoshop CC. Es un canal
de comunicacién directo entre Photoshop y Flame Painter 3 Pro para el intercambio de las
capas.

Instalacion
Su paquete de instalacion contiene de tres carpetas:

Mac OS
Windows
Photoshop plugin

Instalacién para Photoshop CS5 y CS5.5

Copie el archivo "Flame_Painter_Connect_1.2.swf" desde la carpeta“Photoshop plug-in” a la
carpeta de instalacion de Photoshop:

- Windows 32bit: C:\Program Files (x86)\Adobe\Adobe Photoshop CS5\Plug-ins\Panels\
- Windows 64bit: C:\Program Files\Adobe\Adobe Photoshop CS5 (64 Bit)\Plug-ins\Panels\
- Mac OS: /Applications/Adobe Photoshop CS5/Plug-ins/Panels/

Instalacién para Photoshop CS6 y CC

PASO 1: Abra la carpeta "Photoshop_plugin" y haga doble clic sobre incluido archivo
"Flame_Painter_Connect_1.2.zxp". Si el archivo no esta asociado con Extension Manager
automadticamente, abra su Extension Manager y seleccione desde el menu: File =2 Install
Extension (Archivo = Instalar Extension).

PASO 2: La ventana de Extension Disclaimer se abre - haga clic en “Accept”/ "Aceptar".

PASO 3: Se abre una ventana que dice que “a publisher cannot be verified” (el publicador no
puede ser verificado) - haga clic en “Install/"Instalar".

PASO 4: En caso de tener mas productos de Adobe y las extensiones instaladas en su
ordenador, una nueva ventana se puede abrir que requiere que usted elija la versién de
Photoshop para que desea instalar un plug-in.

Si Extension Manager no esta instalado en el sistema, o plug-in de instalacién no es valido,
copie manualmente el archivo de "Flame_Painter_Connect_1.2.zxp" a la carpeta de instalacién
de Photoshop:

- Windows 32bit: C:\Program Files (x86)\Adobe\Adobe Photoshop CS6\Plug-ins\Panels\
- Windows 64bit: C:\Program Files\Adobe\Adobe Photoshop CS6 (64 Bit)\Plug-ins\Panels\
- Mac OS: /Applications/Adobe Photoshop CS6/Plug-ins/Panels/



Como iniciar Flame Painter Connect

PASO 1: Inicie ambos Photoshop y Flame Painter 3 Pro

PASO 2: En Photoshop, cree un document nuevo
desde el menu: File / Archivo = New / Nuevo...

PASO 3: En Photoshop haga clic en el menu:

Window -> Extensions -> Flame Painter Connect. El
nuevo panelo de Flame Painter Connect aparece en la
parte derecha de la pantalla.

Como intercambiar capas

Exportacion de Photoshop a Flame Painter

Seleccione una capa en Photoshop que desea exportar a Flame Painter y haga clic en el botdn
"PS to FP". Si selecciona una capa vacia en Flame Painter, una capa de Photoshop se exportara
a esta capa vacia. De lo contrario, se creara una nueva capa.

Exportacion de Flame Painter a Photoshop

Seleccione una capa que desea exportar a Photoshop y haga clic en el boton “PS” en el panel
de Capas, o desde menu: Layer -> Export to Photoshop (atajo: Ctrl-F para Windows, Cmd-F
para Mac 0S). Si selecciona una capa vacia en Photoshop, una capa de Flame Painter se
exportard a esta capa vacia, de lo contrario, se creara una nueva capa.

Capas exportadas mantienen su nombre original y opacidad. La mayoria de los modos de fusion
copia también sus ajustes preestablicidos originales.

Nota: La siguiente opcion tiene que estar desactivada en Photoshop: Edit -> Preferencies ->
Interface -> Auto-Collapse Iconic Panels.

Si estd activada, el panel de Flame Painter Connect cierra cuando se cambia a Flame Painter
para exportar una capa. Cuando el panel de Flame Painter Connect estd cerrado, la
transferencia de la capa a Photoshop no funcionard.

Eso significa que el panel de la Flame Painter Connect tiene que ser siempre visible cuando se
exporta.



¢Como mantener el mismo tamaiio del lienzo en Photoshop y Flame Painter 3

Opcion 1:

Opcidn 2:

Opcidn 3:

Opcion 4:

Pro?

Abra Photoshop.
Al exportar la capa de Photoshop, la aplicacion de Flame Painter se abrira con
el tamano de la capa exportada.

Abra Photoshop y Flame Painter 3 Pro.

Al exportar la capa de Photoshop y hay un nuevo documento sin cambios en
Flame Painter, el nuevo documento se redimenzionado a el tamafo de la capa
exportada.

Abra Flame Painter 3 Pro y Photoshop.

Abra Flame Painter Connect en Photoshop. Al exportar la capa de Flame
Painter, el nuevo documento serd creado en Photoshop con el tamafio de la
capa exportada.

Ajuste manualmente el mismo tamafio del lienzo en ambas aplicaciones.

Nota: En caso de que aparezca el mensaje siguiente mientras se trabaja con Flame Painter
Connect, compruebe si tanto Flame Painter y Photoshop se estdn ejecutando.

r

]

It seems that Photoshop or Flame Painter Connect is not running.

Ensure that Photoshop is running on your system
and Flame Painter Conneckt plug-in is installed and running in Photoshop.

Si todo estd configurado correctamente, este mensaje puede aparecer al exportar desde
Photoshop y significa que se toma demasiado tiempo para Photoshop para procesar la
recuesta. Haga clic en "OK" y esperar unos segundos para que la imagen exportada aparezca en
Flame Painter.



Creacion, Carga y Guardar de Pinturas

Creacidn de una nueva pintura

Para crear una nueva pintura, seleccione la opcion New... / Nuevo... en el File Menu / Menu de
Archivo. Al hacer esto, aparecera el panel de Archivonuevo. Este panel le permite ajustar el
tamafio de la nueva pintura, y configurar los ajustes del lienzo que va a pintar. También se
puede cambiar el tamafio durante su pintura. En seccidn "Picture Size Info” / Info de Tamafio
de Imagen " puede comprobar el tamafio de impresidn de la imagen.

Color Button / Boton de Color le permite seleccionar el color del fondo o la eleccion del fondo
Black / Negro o White / Blanco preestablecido.

Por ultimo, haga clic en OK para crear una nueva pintura, o Cancel / Cancelar, si no lo desea.

La Apertura de una Pintura

Para abrir una pintura, seleccione la opcién Open... / Abrir... en el Menu de Archivo. Este panel
le permite abrir una imagen o ilustracion previamente guardada y ajustar las caracteristicas.

Por ultimo, haga clic en OK para abrir lapintura, o Cancel / Cancelar, si no lo desea.

También puede Drag and Drop / Arrastrar y Soltarimagenes directamente desde cualquier
fuente - carpeta, navegador o pagina web yse abre como una nueva capa.

Guardar una pintura

Para guardar la pintura, utilice la opcidn Save... / Guardar... en el Menu de Archivo. El formato
por defecto es FPA formato de archivo, que contiene toda la informacion acerca de la pintura 'y
las capas. Utilice esteformato si desea continuar con la pintura posterior.

En Flame Painter 3 Pro se puedeabrir y guardar PSD archivos con capas para Photoshop, Gimp
u otros programas de mapa de bits quesoportan formato de archivo PSD - con todas las
configuraciones de capas, modos de fusidn y opacidad. Es posible exportar las capas vectoriales
como un archivo en formato SVG para lllustrator u otros editores de graficos vectoriales,
donde se puede continuamente editar la forma su flame imagenes en los vectores.

También puede elegir otros formatos de archivo, pero éstos no contienen toda la informacién
sobre la pintura y no se puede abrir correctamente (el color del fondo puede ser diferente, o la
transparencia puede no haberse guardado en formato JPG).

Si desea guardar la pintura con la configuracién especifica o de forma que pueda ser leido por
otras aplicaciones, utilice la opcion Save As... / Guardar como... del Menu de Archivo. Le
permite guardar la pintura en formato PSD, PNG, TIF, BMP o JPG.

Por ultimo, haga clic en OK para guardar la pintura o Cancel / Cancelar si no lo desea.



Publicar una pintura a la Galeria

Crear una Cuenta de Galeria

Para publicar sus pinturas, en primer lugar hay que crear una cuenta. Para crear una cuenta,
tiene dos opciones:

De aplicacién:

Crea tu Cuenta de Galeria desdeel Menu de Flame Painter: Archivo -> Preferencias de Publicar
(File->Publish Preferences). Elija Su Nombre, Correo Electrénico ("Su ID") y la Contrasefia para
la galeria y, opcionalmente el enlace a su Pdgina Web.

De web:

En Pagina web de la Galeria haga click Inicio de sesiéon -> Crear cuenta (login -> Create
Account) e introduzca "Su ID" (correo electrénico de su registracion).

Le enviaremos una Contrasefia, que se puede cambiar mas adelante.

Nota: Puede encontrar "Su ID" en el menu de Flame Painter Ayuda -> Acerca del Flame Painter
(Help -> About Flame Painter).

Si "Tu ID" no existe, introduzca su direccion de correo electrdnico activo.

Publicar pinturas del Flame Painter a la Galleria

Para publicar su pintura, utilice la Publish... / Publicar... opciéon en el Menu de Archivo.
Introduzca el Nombre de la Pintura, un Descripcidn y Etiquetas de Pintura. Haga clic en el botén
Publish / Publicar. Tu foto serd publicada en la pagina web de Ila Galeria
(www.escapemotions.com/gallery), donde puede editar las imagenes mas tarde.

Editar tu perfil y Pinturas en la Galeria

Si ya ha creado una cuenta, vaya al sitio web de Gallery, pulse Login / Iniciar session
eintroduzca"Su ID" y la Contrasefia/Password.

En la secciéon Edit Pictures / Editar imagenes se puede editar el nombre de las pinturas,
descripcidn, etiquetas y otros ajustes.

En la seccién My profile / Mi perfil puede cambiar su Contrasefia.



Atajos de teclado

New... / Nuevo...
Open... / Abrir...

Save / Guardar

Save As... / Guardar Como...
Import.../ Importar...
Publish.../ Publicar...
Quit / Quitar

Undo / Deshacer

Redo / Rehacer

Copy / Copiar

Paste / Pegar

Export to Photoshop / Exportar a PS

Brush / Pincel

Pen / Pluma

Eraser / Borrador

Fill / Relleno

Transform / Transformar

Edit Vector Layer / Editar Capa Vectorial

Increase Value +1 / Aumentar el Valor +1
Decrease Value -1 / Disminuir el Valor -1
Increase Value +10 / Aumentar el Valor +10
Decrease Value -10 / Disminuirel Valor -10
Clean Layer / Limpiar la Capa

Move a Canvas / Mover Lienzo

Zoom In / Acercar

Zoom Out /Alejar

Zoom 100% / Acercar 100%
Zoom In | Out / Acercar | Alejar

Quitar Hires Render

Safe Boundary

Cursor Show |Hide / Mostrar|Ocultar Cursor
Brush Dots Show |Hide / Mostrar|Ocultar
Puntos de Pincel

Fullscreen / Pantalla completa
Show Main Menu / Mostrar Menu Principal
Help / Ayuda

Windows
Ctrl-N
Ctrl-0
Ctrl-S

Ctrl -Shift-S
Ctrl-Shift-O
Ctrl -P

Ctrl -W

Ctrl -z
Ctrl -Shift-z
Ctrl-C
Ctrl-v
Ctrl-F

<=7 m>pP

Up
Down

Pg Up
Pg Down
Del

Botdn derecho del ratén
Escpaciador + LMB

Ctrl - +
Ctrl - -
Ctrl-0

Desplazamiento

Esc

Ctrl-B
Alt-C

Alt-D
Ctrl —L

Ctrl—M
F1

Mac OS
Cmd-N
Cmd-O
Cmd-S
Cmd-Shift-S
Cmd-Shift-0
Cmd-P
Cmd-Q

Cmd-Z
Cmd-Shift-z
Cmd-C
Cmd-V
Cmd-F

< 4T m>P

Down

Pg Up
Pg Down
Del

Cmd -+
Cmd - -
Cmd-0

Esc

Cmd-B
Alt-C

Alt-D
Cmd-L

Cmd-M
Cmd+?



Paint Tool / Herramienta de Pintura 1 1
Edit Tool / Herramienta de Editar 2 2
Group Edit Tool / Herram.de Grupo Editar 3 3
Add & Remove Tool / Agregar y Quitar 4 4
Curve Transform / Curva de Transformacion 5 5
Init Curve Transform / Curva

de Transformacion Init 6 6

Version Personal contra Version Profesional

Versidn personal es mas adecuada para los usuarios que quieren tener una herramienta
creativa completa, pero no necesitanusarlas funciones avanzadas y novenden las imdagenes
creadas o modificadas en Flame Painter. La licencia permite instalar Flame Painter en varios
ordenadores para solo usuario para el uso personal y no comercial o para actividades sin fines
de lucro.

Version profesional es mejor para los profesionales y los usuarios que necesitan funciones
avanzadas como Capas Vectoriales o conexidn con Photoshop. La licencia permite la instalacién
de Flame Painter en un ordenador para las empresas; o en varios ordenadores paraun usuario
unico. Esta licencia permite la utilizacion del software para el uso comercial o actividades de
beneficio, asi como para las actividades no comerciales.

Para mas detalles, lea el Acuerdo de Licencia de Software completo.
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QuaZIP - LGPL license (2.1) - http://sourceforge.net/projects/quazip/

CryptoPP - Boost Software License (1.0) - http://www.cryptopp.com/
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AntiGrain Geometry 2.4,LGPL license - http://agg.sourceforge.net/antigrain.com/index.html
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Flame Painter End-User Software License Agreement

Copyright 2012 - 2014 Escape Motions, s.r.o. All Rights Reserved.
Copyright 2009 - 2012 Peter Blaskovic. All Rights Reserved.

This license is a legal agreement between you and Escape Motions for the use of Flame Painter
software (the "Software"). By downloading, installing, copying, or otherwise using the
Software, you acknowledge that you have read terms and conditions of this license,
understand them, and agree to be bound by them. If you do not agree with these terms and
conditions, Escape Motions is unwilling to license the Software to you, and you are not
authorized and may not use the Software.

Permitted Use
Flame Painter Personal:

Users of the Flame Painter may use the Software for personal, non-commercial, or non-profit
activities.

You may install the Software on multiple computers provided that not more than one of those
computers is in use simultaneously and that those computers are solely for your own personal
use.

Flame Painter Professional:

Users of the Flame Painter may use the Software for commercial, or for-profit activities as well
as for personal, non-commercial, or non-profit activities.

The Software may be installed on a computer that is for multiple users but it may not be
installed on more than one computer regardless of whether those computers are operated
simultaneously or not.

You may install the Software on multiple computers provided that not more than one of those
computers is in use simultaneously and that those computers are solely for your own personal
use.

You may not remove the copyrights notices from the Software. You may make one (1) copy of
the Software for back-up or archival purposes.

Restrictions

This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law
and international treaty. This is a license, not a transfer of title, and unless you have been
granted prior, written consent from Escape Motions you may not:

a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party.

b, Sell, rent, lease, assign, or sublet the Software or portions thereof.



¢, Grant rights to any other person.

d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on the
Software or the documentation in whole or in part.

e, Use the Software in violation of any international law or regulation.

You must not intentionally or unintentionally make the Software available on any web server,
ftp server, file sharing network, shared directory, or other location where any other person can
acquire a copy of the Software. You are responsible for keeping the Software safe from being
copied by others.

Display of Copyright Notices

All copyright and proprietary notices and logos within the Software files must remain intact.

Indemnity

You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions or
suits, as well as any related expenses, liabilities, damages, settlements or fees arising from your
use or misuse of the Software, or a violation of any terms of this license.

The Software may contain technical inaccuracies or typographical errors, so changes and/or
updates may be affected without notice.

Peter Blaskovic may also make improvements and/or other changes to the Software at any
time without notice.

Disclaimer Of Warranty

THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR
IMPLIED, AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO,
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR
FITNESS FOR A PARTICULAR PURPOSE. FURTHER, PETER BLASKOVIC DOES NOT WARRANT THAT
THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE.

Limitations Of Liability

YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE FOR
CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION WITH
THE SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING BUT
NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST
PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS.



